
10 Points                                                                           Due in class Wedne sday, September 6 

Get Familiar with Spreadsheets 1 

 
Spreadsheets are computer programs that allow the user to enter and manipulate numbers.  They 
are capable of performing any calculation that has a mathematical formula.  One advantage of 
spreadsheets over calculators is that it is easy to double-check data entries and replace mistyped 
numbers, since the data is all plainly visible to the reader.  More importantly, spreadsheets allow the 
automation of repeated tasks. Spreadsheets are also used to make graphs of experimental data and 
to fit functions to the data.  Basic knowledge of spreadsheets is important at Truman because they 
are used in many advanced science courses. 
 
These instructions are written for Excel 2010.  Other editions of Excel and other spreadsheets, such 
as Open Office or Numbers, are substantially similar.  In order to "right click" with a Macintosh, 
you can hold down the command key and click, you ca n tap the touchpad with two fingers, or 
you can click the lower right-hand corner of the mo use button. 

STARTING THE PROGRAM 

Go to the Start button, select All Programs, go to the Microsoft Office folder, and select Microsoft 
Excel.  

SPREADSHEET CELLS 

The core of a spreadsheet is a two-dimensional array of rectangular cells.  Each of these cells has a 
name derived from the row and column in which it lies.  The columns are labeled alphabetically, and 
the rows are numbered.  Using this system, the upper left-hand cell is named A1.  Likewise, the cell 
two columns to the right of the top left corner is C1, and the cell five rows down from that spot is C6.  
 
One of the reasons why spreadsheets are so flexible is that you can use the name to represent the 
contents of the cell.  For example, enter the number 5 in cell A1 and the number 2 in cell B1.  Now 
select any open cell and enter the formula =A1/B1 or +A1/B1.  (The equal or plus sign tells the 
program that you are entering a formula.  Without = or +, the computer does not recognize a 
formula .)  When you press Enter, the number 2.5 appears in the cell.  Notice that the formula still 
appears in the space between the tool bar and the body of the spreadsheet, while the numerical 
result of that formula is displayed in the cell.  You can now go back and change any of your entries. 
For example, change the contents of A1 to 12, and the spreadsheet automatically recalculates the 
result of the equation, since A1 changed.  

ENTERING DATA 

Clear the contents of the cells you have used so far.  First, highlight the cell(s) you wish to clear 
using click and drag (holding down the left mouse button).  Then, right click somewhere in the 
highlighted area and select Clear Contents. 
 
Now try calculating the squares of the first six multiples of five.  Starting 
with cell A1, enter the following numbers in column A:  0, 5, 10, 15, 20, 
25, 30.  In cell B1, enter the formula =A1*A1.  After entering this formula 
the result should be 0.  You could then enter the formula =A2*A2 in cell 
B2, and so on.  Instead, copy and paste the contents of cell B1 to the 
cells below it.  To do this, place the cursor on the lower right corner of 
cell B1. The cursor will change from the open white cross (select cell 
cursor) to a black cross (copy cell cursor, as in figure 1.).  Holding the 
left button down, drag the cursor across the cells you wish to copy the 
data to (in this example, drag down to cell B7).  The formula should 
have been copied into the cells with changes automatically made so that each copied formula refers 
to the correct piece of data in column A.  
 

 

Figure 1: The copy cursor 
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GRAPHING EXERCISE # 1: Problem 1.83c(ii) 

Clear the contents of the cells you have used so far, or start a new sheet.   
 
Problem 1.83 in our CHEM 130 textbook, Petrucci/Herring/Madura/Bissonette, General Chemistry 
10th ed., asks the question, at what temperature is the density of liquid water a maximum, and what 
is the density there?  The question gives an equation which can be used to relate the density of 
liquid water to the Celsius temperature in the range from 0 ºC to about 20 oC: 
 
 
 
 
To answer this question, you should create a graph using the equation above.  (Excel calls a graph 
a "chart".)  To do this, first create column headings that tell an observer what the numbers in each 
column are.  In cell A1 type “Temperature (°C)”, and in cell B1 enter “Calculated density of water 
(g/cm3)”.  To get the degree sign, place your cursor where you want the sign, click on the "insert" 
tab, and select "symbol".  Now scroll to "latin 1" under "subset" and insert the "o" from the middle 
right side of the choices.  In cell B1 highlight the “3” and make it a superscript by right clicking on it 
and selecting "format cells".  Click the box to select superscript, and click "okay" to get back to the 
sheet. 
 
Now enter the temperature data.  In cell A2 type “0” and in cell A3 type "=a2+1" or "=a2+0.5"  (Excel 
will automatically convert the lowercase letters to uppercase.)  Copy the formula in cell A3 down the 
column until the last cell displays a value of 20.  These will be the values for temperature from 0 to 
20 oC. 

 
In cell B2 enter the equation given above, starting with "=" and replacing the 
variable T with A2.  (Use * when you wish to multiply.)  There will be many 
parentheses in this equation- type carefully and keep track!  Also, remember 
that excel does not recognize superscripts in formulas, so use E-2 instead of 
10-2, and use the caret (^) symbol to enter A22 (A2^2).  Once the equation is 
entered, copy cell B2 down column B as far as you have values in column A.  
The result of the equation will show in column B.  If you have successfully 
entered the equation, the numbers in your columns will look like those in 
figure 2. 
 
To build a graph of the data, highlight both columns of data (just the 
numbers, not the column headings), go to the Insert tab in the menu bar, 
and find the Charts box. Select "Scatter", then "Scatter with only Markers" 
(the top left option with nothing but dots on the chart icon) as the chart type, 
since you have xy data points.  Excel automatically assumes that the first 
selected column is the "x" data, and all following columns are "y" data.   
Once the chart is created, there are options available under the layout tab to 
insert a chart title, axis labels, legends, and gridlines.  For the Layout tab 
to be displayed, the chart must be selected.   Enter a chart title and label 
the axes.    Include the units in the axis labels!  A chart title should be 

descriptive, and not just a reprint of the axes.  For example, "Density vs Temperature" is a poor title 
for this chart.  A better title would give an idea of why this is being plotted.  This is called a 
descriptive title.  Something like "Determination of the maximum density of water" is a better title for 
this graph. 
 
Gridlines and the Legend give you additional formatting options, which you might wish to use on 
some graphs.  You can explore the options, but in almost all cases, you will want to delete the 
gridlines in order to keep the graph neat and easil y readable . If there is only one data series (as 
in this graph), you should also delete the legend in order to clean up the graph a little bit more. Do 

 

Figure 2. Results from 

correct entry of the 

equation (using steps of 

1) in column A 
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this by selecting the legend and hitting "delete".  If there is ever more than one series (more than 
one y column being graphed), keep the legend and give each series a name.  
 
Question:  At what temperature is the density of li quid water a maximum, and what is the 
density there?  
 
To answer this question visually, it is very practical in this case to choose to show both vertical and 
horizontal gridlines.  Have excel show them by selecting them in the Chart Options menu, and turn 
the graph in with the gridlines showing, and your answer to the question written on the graph. 
 
You are now going to move the chart to a new sheet because in courses such as CHEM 130, a 
graph should cover about half a page (or more) when it is printed out for your notebook.  This makes 
graphs easy to read.  To do this, select the Design tab of the menu bar. Click on the Move Chart 
icon in the Location box, and select New Sheet. This will put the chart on its own sheet so you can 
resize it at will.  To keep the sheets well organized, you will want to give the sheet a name indicating 
what information is on it. At the bottom of the screen, there are tabs labeled “Sheet 1”, etc. When a 
chart is moved to a new sheet, that sheet will be named “Chart 1” unless you rename it. To switch 
between different sheets and charts, click on the tabs at the bottom. 

GRAPHING EXERCISE # 2: Chemical Kinetics 

Open a new sheet and enter the following data into blank cells: 
 

Time, 103
 s [N2O5], mol/L 

0 2.57E-3 
4 1.50E-3 
8 0.87E-3 
12 0.51E-3 
16 0.30E-3 

 
Enter the time data in one column and the concentration data in the adjacent column.  Title your 
columns.  To make a superscript "3" in the title of the time column, type "Time, 103 s" in the top box, 
then superscript the 3 using the procedure in exercise #1.  Make subscripts in a similar manner.  
You must enter 2.57E-3 and the other concentrations  exactly as written.   Excel does not 
recognize superscripts in formulas, so engineering notation (E-3) or the caret (*10^-3) must be used 
instead.  Observe how Excel automatically rewrites 0.87E-3. 
 
Now, using the procedure in exercise 1, make a graph with time on the x axis and concentration of 
N2O5 on the y axis.  For this exercise, and for most of the CHEM 130 and  CHEM 131 labs, 
delete both the gridlines and the legend.   Delete the gridlines by clicking on a gridline (not on an 
axis), then hitting "delete".  Delete the legend too.  Now the graph should contain only the axes and 

the data points. 
 
Now it is time to use a graph!  As explained in chapter 14 of Petrucci, it 
is possible to determine the relationship between reaction rate and 
reactant concentration by plotting various functions of the concentration 
vs. time.  For example, if the rate of reaction of N2O5 has a first-order 
dependence on the concentration of N2O5, then a plot of the natural log 
of the concentration vs. time will give a straight line.   
 
To plot the natural log of the concentration versus time, you need a new 
column of data, with the natural log of the time values in it.  Return to 
the data spreadsheet and make a third data column (in column C) using 

the formula =ln(B2), where ln is the natural log, as shown in figure 3.  To make a new graph (of 
natural log of the concentration vs. time), the appropriate blocks of data need to be highlighted.  The 

 

Figure 3.  Excel shows you the cell you 

are telling it to use in the calculation. 
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x-values are still in column A, but now the y-values are in column C.  To highlight data in columns 
that are not next to each other, first highlight the data in column A, then hold down the control key 
("command" key on a Mac) and highlight the data in column C. Follow the same directions as before 
to create a graph. 
 
At this point your graph violates a guideline on graphing: do not show any more empty space 
than you need to!   The y-axis goes from 0 down to -10, but the data only covers part of that range, 
from -5.96 to -8.11.  There is a lot of empty space, so get rid of it.  To do this, change the y-axis 
scale by right-clicking on any y-axis value.  Left-click on Format Axis, select Fixed in the Maximum: 
option, and change the maximum to -5 or -5.5, or something else more reasonable than 0.  While 
you are here, change the minimum too, to a closer number such as -8.5 or -9.  Now click "close".  (It 
is all right if the x-axis now crosses at the top of the graph.)  Also, since there is only one series on 
the graph, delete the legend. This should leave you with a clean, zoomed-in graph that has very little 
empty space. 
 
In chemical kinetics it is very useful to know the slope of the best-fit line through a linear rate graph.  
In order to fit such a line to your graph, select any one of the data points by right-clicking on it.  
Select the option to "add trendline" and in the dialog box that appears select "linear" (it will probably 
already be automatically selected) and click the boxes to show the equation and the R-squared 
value on the chart.  Click "okay" and there should be a best-fit straight line through the data.  The 
equation for the line and the goodness-of-fit (or R2) value will also be displayed. 
 
You will turn in the best-fit graph, with the line of best fit and R2 value displayed.  This graph is 
intended to determine if the reaction is first-order in N2O5 or not, so give it a descriptive title to that 
effect.  Remember to label the axes also, but remember that the log of a number has no units, so the 
y-axis in this case is unitless. 

VOLUNTARY EXERCISE 

For your own benefit, you will want to make the Excel tables for the Determination of Density 
experiment.  You can do this now, when you are going strong on Excel, or you will need to do it 
later, when you will be busy with other things before or during lab.  It is best to do it now! 
 
The density experiment is on the chemlab.truman.edu website under the "chemical principles" 
heading. 

WHAT TO TURN IN 

You will turn in two graphs: the graph from exercise 1 (with the gridlines showing and the 
temperature of maximum density indicated), and the natural log graph from exercise 2 (with the 
best-fit line and equation and the R-squared value showing).  Put both graphs on one piece of 
paper, either by printing on two sides, or by copying and pasting both graphs onto one excel or word 
sheet, one above the other.  You should make each graph take up slightly less than half a page, so 
they will both be large enough to easily look at, but also both fit on one page.  Both graphs should 
have proper axis labels with units, and descriptive titles.  Only hand in one sheet of paper, and 
don't forget to put your name on the page!  
 
There is a more complete set of instructions for using Excel 2010 at http://vpultz.sites.truman.edu/ 
The instructions there show (among other things) how to calculate the average value from the 
values in a large number of cells, or how to sum over multiple cells using a formula such as 
=SUM(A2:B2).  Refer to these instructions over the semester if you are stuck and cannot find 
anyone to help you. 

REFERENCES 
1. This document was modified from an exercise created by Vaughan Pultz, Tim Humphry, and 

Amy Fuller. 


